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About this Guide 
Overview 

This guide is designed to assist in installing and configuring the System Manager software. 

Disclaimer 

These instructions have been prepared by Philips Dynalite and provide information on Philips Dynalite products 
for use by registered owners. Some information may become superseded through changes to the law and 
because of evolving technology and industry practices. 

Any reference to non- Philips Dynalite products or web links does not constitute an endorsement of those 
products or services. 

Copyright 

© 2022 Signify Holding. All rights reserved. Specifications are subject to change without notice. No representation 
or warranty as to the accuracy or completeness of the information included herein is given and any liability for 
any action in reliance thereon is disclaimed. Philips and the Philips Shield Emblem are registered trademarks of 
Koninklijke Philips N.V. All other trademarks are owned by Signify Holding or their respective owners. 
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Technical Support Contacts 

Contact Controls, Systems & Services, Philips Lighting call desk for assistance with hardware 
or software questions: 

Email 

support.controls@signify.com 

Web 

www.dynalite.com 

Conventions 

 

 

 

 

 

 

 

  

C Caution: highlights safety issues or where there is a risk of permanent damage to equipment.  
 

D Note: highlights key factors that needs to be considered. 

E Tip: highlights shortcuts, accepted conventions and best practice. 

mailto:support.controls@signify.com
mailto:support.controls@signify.com
http://www.dynalite.com/
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Introduction 
System Manager (SM) is the head-end software solution offered by Philips Dynalite.  
SM enables centralized control of the entire lighting system or parts of the lighting system 
based on individual user permissions. 

SM is developed to deliver industry leading levels of control, monitoring and maintenance of 
lighting systems. The software is compatible with all current Dynalite products/solutions and 
can be used on any Philips Dynalite project. Moreover, it is able to integrate seamlessly with 
Building Management Systems to support the needs of a fully integrated building.  

The software provides insights into the way a lighting system is operating, highlighting areas 
where improvements can be made on a daily operational basis as well as part of long-term 
strategies and delivering the flexibility to optimize energy efficiency and maximize user 
comfort. 

SM is designed to meet the needs and expectations of both building users and facilities 
managers. 

Standard commissioning using System Builder creates a configuration file which becomes 
the basis for System Manager; leaving the commissioning engineer to focus on setting up 
the tailored interface to best match the end-user needs. 

SM further facilitates a wide range of lighting system management and maintenance 
activities. The maintenance functionality of SM can identify luminaires approaching the end 
of their lamp life or which have already failed, as well as failed ballasts and other faults on 
the system. The alerts overview provides a summary of current alerts with details on the 
state of each item. This helps the building/facilities manager prioritize and address 
maintenance activities, both planned and unplanned. 

 

 

 

 

 

 

 

 

 

  

System Manager at a glance: 

• Controls, manages and monitors lighting systems 

• Seamlessly integrates with Building Management 
Systems (BMS) 

• Allows activity scheduling 

• Generates performance reports 

• Simple to implement as it makes use of the System 
Builder configuration file 

• Enables easy maintenance 
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Installation components 

Server Installation 

This section lists the software installed for System Manager. 

The server installation consists of two components that are installed separately. 

1. Prerequisite Software installation 
2. Philips Dynalite System Suite installation 

The Prerequisite software installation installs the components required for successful 
installation and working of Philips Dynalite System Suite software. 

Client installation 

The client software is installed on the server by default. You can install multiple versions of 
the client software on different PCs to access System Manager.  

D Note: A maximum of 15 concurrent SM client users is recommended. 

SM Client Integrates with and uses Windows Domain Security Groups and User Rights 
configurable on a user and group basis.  

Install SM client: 

1. Copy the installation files located in the following folder on the SM server: 

"C:\Philips Dynalite\System Manager\System Manager Client" 

2. Run setup.exe on a user’s PC. 

3. In Windows, click  System Manager to open the System Manager client. 

Optional client 

System Dashboard 

Optional BMS Interface 

OPC proxy server application 
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The Prerequisite installer performs a check on the system and installs the following: 

Names of the software components installed after running Prerequisite installer 

Microsoft .NET Framework 3.5 SP1 (Windows Feature) for Windows 8 

Microsoft .NET Framework 4.0 Full for Windows 7 and below OS 

Microsoft Visual C++ 2010 Redistributable package (x64) 

Microsoft Visual C++ 2010 Redistributable package (x86) 

MSXML 4.0 SP3 for all OS 

Microsoft SQL Server 2012 (x86 & x64) 

 

Philips Dynalite System Suite installer has the following components: 

Component Sub-Components 

System Manager System Manager Server communicates with the Client software (System 
Manager and Switch) 

System Manager Configuration for configuring the database, site users and 
site settings  

System Builder commissioning software. The version installed is compatible 
with Philips Dynalite System Manager Suite. 

Client Setup Repository 

 

System Manager Client software used to control, monitor and maintain 
lighting systems. 

Switch is a software application that can be linked to a computer’s screen-
saver to control the lights above the desk where the computer is placed 

 

D Note: For information on making the system and server more secure, please refer to the 
System Hardening Guide and the OS Hardening Guide 
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Prerequisite Software Installation 

Ensure that “EMSERVER” instance is created in SQL Server (either licensed SQL or SQL 
express). Once it’s available, then when prerequisite is run, it will skip SQL installation as the 
machine already has it installed. 

D Note: If the customer would like to use a licensed SQL server on a remote machine, then the 
prerequisites installer will install a local “EMSERVER” SQL Express instance. They would then have 
to point SM at the remote SQL server instance when they run the SM installer. They could then 
delete the local “EMSERVER” SQL Express instance. 

Follow the steps below to install the prerequisites 

1. Right click the System Manager prerequisite setup file from an explorer window and 
select Run as administrator. 

 

2. System Manager Prerequisites wizard is displayed; click Install to start the 
installation. 

 

The System Manager prerequisite software starts to install.  

Once the prerequisite software is installed the wizard ends automatically.  
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Philips Dynalite System Manager Suite Installation 

D Note: to enable Dynalite APIs and System Dashboard, you must first install Postgres 
SQL database and configure Microsoft Internet Information Services. Please follow the 
installation steps in the Dynalite API User Guide. 

 

1. Right click the System Manager setup file from an explorer window and select Run 
as administrator. The Philips Dynalite System Manager – InstallShield Wizard is 
displayed. 

 

2. Click Next. 
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3. Accept the license agreement and click Next. 

 

If required change the installation folder via the Browse button and click Next. 
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4. Select the features to install from the list and click Next. 
Select System Manager and/or Client Setup Repository depending on the 
requirements. 

D Note: If you want to select Data Access to enable the APIs and System Dashboard, 
then please cancel the installation and follow the Installation steps in the Dynalite API 
User Guide. 

 

5. Click Install to install the selected features. 

 

The installer installs files into different destination folders. System Manager related 
files are stored in the Program Files folder. The client files are stored at Windisk, for 
example: 

C:\Philips Dynalite\System Manager. 
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During the installation the progress is shown. 

 

A second pop-up notifies that the SQL server instances are connected 

 

Once the installation is completed, the wizard displays a message to confirm that 
System Manager Server and Databases are created. This indicates successful 
creation of SQL instance and database creation 
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After the database creation, a message is displayed to indicate Philips Dynalite 
System Suite installation was successful.  

The SM installer installs the following program shortcuts on the computer. 
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System Manager Configuration 

The System Manager Configuration tool is used to configure the System Manager Server 
settings for network connection, logger, databases and services. The SM configurator can 
also be used to create and manage users of the System Manager client software. 

System Manager Configuration Tool wizard has the following features: 

• Request License  

• Apply License 

• Select Job Type 

• Choose EP File/Select Configuration Database 

• Create Site Owner 

• Execute Actions 

Site licensing 

1. Select System Manager Configuration from the menu displayed above. The System 
Manager Configuration tool is displayed. 

 

 

D This wizard can be re-run anytime by clicking the Run Quickstart 
button. 
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2. Click Request License to license the software. 

 

3. Enter the site details and click Send License request. This uses the standard email 
application on the computer to generate an email to support.controls@signify.com 

The support team then replies with an email with the license file within 24 hours. 

D Note: In case no email client is installed, the Save License Request 
button can be used to save the license request to a file. In a next step this 
file can be sent via email to Philips to request a license. 

Applying License 

1. Click Apply License from the main screen. 

2. Browse and select the license file. 

3. Click Open. 

 

The System Manager license for the specific site is applied. 

D Note: A license copied to the clipboard will be applied automatically. 

  

mailto:support.controls@signify.com
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Configuring System Manager 

Perform the following steps to select the database and configure users. 

1. Click Run Quickstart. This opens the wizard for configuring System Manager. 

 

It is possible to start from an System Builder job file or to start from an System 
Manager Configuration Database. Click Next. 

2. Select Start from System Builder job file and the below window is displayed. 

 

Click Browse and upload the System Builder job file. Click Next.  
Continue with step 4. 
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3. Choose Start from an System Manager Configuration Database, and the below 
window is displayed. 

 

Select the Server Name as, “.\EMSERVER” and Database Name as 
“EMServer ConfigurationDB”. Click Next. 

D Note: The “.\” before the server name replaces the computer name. 

4. License the server if it hasn’t been licensed before by uploading the license file. Set 
the checkbox. 
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5. Click Request License to request a new license via email or click Browse to browse 
to a license file already available at the computer. 

 

6. Create a Site Administrator. Set the both checkboxes on the page and click Choose. 
This displays the Select User or Group window 

 

7. Enter the name of the user and click Check Names to verify the name. The full 
username is displayed. Click OK. 

 

Click Next.  
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8. Enter the Location and Time Zone information. Click Next 

 

9. Click Execute to create the databases and owners. 
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10. Click Finish after executing to close the wizard. 

  

The databases and users are now configured. 
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The System Manager Configuration summary page displays vital information regarding the 
job, database, and the services running on the System Manager server. 

The Job Name shows the job status indicator and name of the job 

The job status icon indicates: 

  Loaded successfully from database 

 Couldn’t load from database but using an empty job 

 Failed to load from database 

 Loaded from file 

 Failed to load from file 

The Network Status shows if the system is connected or disconnected. 

The indicators for Job Database, Trending Database and Alarms and Events Database depict 
the following: 

 Database OK 

 Could not get database version (Database may be invalid) 

Upgrade Required 

 Other database failure 

System Manager Service Status, Logger Service Status, NetworkProvider Service Status are 
services that can be in Running or Stopped state. 

It also contains Service status information and License information. 
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Secure connections 

To establish secure Ethernet connections, you must open System Builder on the SM Server 
machine to import a Site CA Certificate (Site Private Key) and save the job/database. The 
Site CA certificate must have been previously exported from the commissioning machine. 
The Site CA Certificate and password must always be stored and sent securely. 

SB is used for site certificate management and uploading to devices. During commissioning, 
the Site CA Certificate is used in the Job to create and upload Device Site Certificates for TLS 
connections between gateways and devices and between gateways and SB/SM.  

Only a PDDEG-S can be used for secure connections. To ensure end-to end security, each 
PDDEG-S and Ethernet Device (ED) must be configured for secure connections in the job 
and saved to devices before importing the job into SM. 

Import Site CA Certificate: 

1. Open System Builder on the SM server machine. 

2. In the Tools menu, select  Set Site CA Certificate to open the Site Certificate 
Selection window. 

 

 

3. Click the Import button and select the exported certificate (.pfx).   
4. When prompted, enter the certificate password. 

 

 

5. Click the OK button. 
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6. Click the OK button. 

 

 

7. Save the job/database. 

 

Hardening 

Please ensure you perform system and OS hardening to prevent unauthorized access to the 
system. 

• For information on hardening the Windows server, please refer to OS Hardening 
Guide. 

• For information on hardening Philips Dynalite System Manager software and 
hardware devices, please refer to System Hardening Guide. 
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SM Client installations 

System Manager Client and Switch are the clients that can be installed on user PCs.  
It is recommended to share this folder with users, so they always have access to the latest 
installation files. 

Install client software: 

1. Navigate to the folder C:\Philips Dynalite\System Manager\ System Manager Client 

2. Enter the folder of the client that must be installed. 

3. Right click the setup file and select Run as administrator. The client application is 
installed. 

The SM client connects to SM server on TCP port 8084. This port is normally open in 
firewalls but if SM client is unable to connect to SM server then the IT department will 
need to ensure this port is accessible. 

Automatic upgrades 
The MageUI manifest file is used to create automatic upgrades for System Manager clients. 

Automatic upgrades for newer versions of client applications is created in two steps: 

1. Share the Philips Dynalite System Suite folder among users. 

2. Specify the file share location in the MageUI manifest file. 

 

Share Philips Dynalite System Suite folder 

1. Right click on the Philips Dynalite System Suite folder and select Share with Specific 
people. File Sharing window is displayed. 
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2. Select the users (with whom the folder needs to be shared) from the dropdown list 
and click Add. 

 

3. Click Share to share the folder amongst selected users. 

 

ClickOnce deployment using the MageUI Manifest file 

ClickOnce deployment allows to publish Windows-based applications to a Web server or 
network file share for simplified installation. 

Specify file share location in Mageui.exe 

1. Navigate to the C:\Philips Dynalite\System Manager\System Manager Client folder. 
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2. Run the mageui.exe file.  

 

3. Select File, Open and open the System ManagerClient. application file.  

 

4. The Click Once application file opened in mageui.exe is displayed. 
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5. Select the Deployment Options. 

 

6. The Start Location in the Deployment options is the file share location where the 
System Manager client versions are placed.  
 
The default location is  
 
\\ServerName\Philips Dynalite\System Manager\System Manager 
Client\EnvisionManagerClient.application 
 
In case a different file share location must be shared, the path of the file share 
location must be specified in the Start Location field. 

7. Select File, Save. 

8. Click Don’t sign to exit 
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Site Settings 
The site settings page is used to configure the background settings for System Manager. The 
settings for the following items can be changed: 

• Network 

• Application Log 

• System Settings 

• Batched Log 

• SMTP Server 

• SMTP Message 

• Presence Detection 

• Public Holidays 

• Notifications 

• Location and Time Zone 

• Data Access 

Click the Site Settings button on the System Manager Configuration Tool to change settings. 

Network 

The following connections can be used to connect to the DyNet network: 

• Serial port 

• TCP 

• UDP  

• Ethernet trunk 

For more information regarding connecting to the network please refer to the System Builder 
Training Guide. 

 

Application Log 

The application log consists of log files that are created for the System Manager application.  

Application Logging 

Write messages to file 
Set to True. 

Log message type 
Select the type of system messages that must be logged. The types of log messages include 
Error, Warning, Information, Detailed information, Debug Error, Debug Warning and Debug 
Information. 

Log file path 
Specifies the path where log files are stored. 

Maximum file size (KB) 
Minimum size 10, Maximum size 10485760. Default 1024 

Log file Removal 

Log file removal method  
The log file is removed after the specified number of days 
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Maximum days to keep saved files: 
Minimum 0, maximum 10000 

Maximum size (MB) of saved log files: 
Minimum size 0, Maximum size 

 

System Settings 

The System Manager Settings window has properties that affect the global operation of 
System Manager. 

Polling  

Spur polling period (milliseconds) 
How often each spur is polled 
Minimum 0, maximum 86400, default 5000 

Enable Roll call polling 
SM sends a sign-on to each device in a specific order to determine whether the device is 
online or offline 
True/False, default False. 

Roll call polling period (seconds) 
Minimum 0, maximum 86400, default 3600 

Enable DALI ballast polling 
SM sends a sign-on to each DALI controller and if online requests the DALI ballast status 
True/False, default False. 

DALI Ballast polling period (seconds) 
Minimum 0, maximum 86400, default 3600 

Enable channel runtime polling (seconds) 
SM sends a sign-on and then reads the channel runtime section of each load controller to 
determine when a lamp has come to the end of its life 
True/False, default False. 

Channel runtime polling (seconds) 
Minimum 0, maximum 86400, default 86400. 

Enable Modbus polling  
True/False, default = False. 

Modbus polling period (seconds) 
Minimum 0, maximum 86400, default 300. 

Enable lux level polling  
True/False, default False. 

Lux level polling period (seconds) 
Minimum 0, maximum 86400, default 3600. 

Enable load current polling  
True/False, default False. 

Load current polling period (seconds) 
Minimum 0, maximum 86400, default 3600. 
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Enable channel level polling  
True/False, default False. 

Channel level polling period (seconds) 
Minimum 0, maximum 86400, default 600. 

Enable area temperature polling  
True/False, default False. 

Area temperature polling period (seconds) 
Minimum 0, maximum 86400, default 600. 

Send separate DALI ballast and lamp failures per Area  
True/False, default False. 

Send combined DALI ballast and lamp failures per Area  
True/False, default False. 

Emergency Test 

Delay before initial query (Seconds) 
Fallback value if “query results only at end” is disabled. In that case the “delay before initial 
query” will specify the time between the start of an emergency test and the start of the 
polling of the first emergency ballast. Minimum 1, maximum 10000, default 5. 

Query delay between emergency ballasts (seconds) 
Time-out before System Manager will poll the next emergency ballast. Minimum 1, 
maximum 10000, default 1. 

Query delay between polling retries (seconds) 
Time-out before System Manager will poll all emergency ballasts again. It is recommended 
to set this time to a value which is bigger than the time to poll the largest emergency 
luminaire group. Minimum 1, maximum 10000, default 60. 

Functional test expiry period (minutes) 
The maximum time before System Manager will stop polling and consider all tests that have 
not retuned a positive result as a failed test. Minimum 1, maximum 10000, default 5. 

Duration test expiry period (minutes) 
The maximum time before System Manager will stop polling and consider all tests that have 
not returned a positive result as a failed test. Minimum 1, maximum 10000, default 240. 

Double send start test command  
In some unique cases it might be required to send a start test command twice to trigger all 
emergency ballasts. Only enable when you experience issues with ballasts which are 
missing start test commands. True/False, default False. 

Enable CBS emergency testing  
Enable this if emergency luminaires are backed up by a central battery system instead of 
local batteries in the luminaires. True/False, default False. 

CBS switch polarity  
Specify if the relay which triggers the test is normally open or normally closed. Default 
Normally open. 
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Delay after switching CBS (seconds) 
Delay to allow central battery system to settle after switching to/from battery. This is the 
delay after switching the relay (to go to battery power) before polling. Minimum 1, maximum 
10000, default 10. 

Update emergency alarms after query results  
Emergency alarms are updated and saved to history only when results are queried as part of 
a ‘start test’. Set to true to also update alarms when performing a ‘query results’ only. 
True/False, default False. 

Query result only at end  
The end is defined by waiting the amount of time defined by “Functional test end query 
time” or “Duration test end query time” setting before querying the result. This setting will 
only be used when tests are triggered from System Manager Emergency Testing GUI or 
through OPC. True/False, default False. 

Query before starting failed ballasts  
When failed ballasts are tested, System Manager will first poll the emergency test status.  
If System Manager stopped polling before a test was finished successfully, a query will 
update the result in SM and a re-test is not required. True/False, default True. 

Functional Test End Query Time (minutes) 
Time out before System Manager will start polling the emergency test result in case “query 
results only at the end” is disabled. Minimum 1, maximum 10000, default 5. 

Duration Test End Query Time (minutes) 
Time out before System Manager will start polling the emergency test result in case “query 
results only at the end” is disabled. Minimum 1, maximum 10000, default 240. 

Behavior 

Lamp end of life (hours) 
Minimum 1, maximum 10000, default 500. 

Temperature unit  
Celsius (°C)/Fahrenheit (°F), default Celsius (°C). 

Minimum temperature setpoint  
Minimum -127°, maximum 127°, default 15°. 

Maximum temperature setpoint  
Minimum -127°, maximum 127°, default 28°. 

Temperature setpoint change unit 
Minimum 0.1°, maximum 10°, default 1°. 

Replace failed lamps automatically 
True/False, default False. 

Automatically deploy schedules when devices become online 
True/False, default False. 

Flash error and offline icon status 
True/False, default =False. 

Length of a day (hours) 
Minimum 8, maximum 24, default 24. 
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Maintain plan zoom level  
True/False, default True.  

Enable Trending  
True/False, default False. 

Cache all plans on site logon  
True/False, default False. 

Request button presets on page load  
True/False, default True.  

Request plan presets on page load  
True/False, default True.  

Use notification event queue  
True/False, default True.  

Session timeout (minutes) 
Minimum 0 (never timeout), maximum 2147483647, default 0. 

Deaf session timeout (minutes) 
Minimum 0 (never timeout), maximum 2147483647, default 60. 

Enable auto logout  
True/False, default False. 

Auto logout timeout interval (minutes) 
Minimum 8, maximum 60, default 5. 

Macros 

Macro delay (ms) 
Minimum 0, Maximum 2147483647, default 0. 

Reports 

Report font 
Select a font or type any installed font to use for reports. 

Report logo file 
Select path to logo image file. 

Archive Path 
C:\ProgramData\Dynalite\EnvisionManager\Reports 

Database Backup 

Backup Path 
C:\ProgramData\Dynalite\EnvisionManager\DBBackup 

Connect to database using SQL Native Client 
True/False, default False. 

Auto Calibration 

Off Preset 
Minimum 1, maximum 24, default 4. 

Calibration timeout (minutes) 
Minimum 1, maximum 60, default 5. 
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Customer Settings 

Client logo file 
Default <empty>. 

Console logo file 
Default <empty>. 

Client help file 
Default <empty>. 

Regions 

Area border color 
R, G, B, A (color + transparency). Default R=255, G=255, B=0, A=255. 

Area fill color 
R, G, B, A (color + transparency). Default R=255, G=255, B=207, A=130 

Area selected color 
R, G, B, A (color + transparency). Default R=255, G=255, B=137, A=200. 

BLA border color  
R, G, B, A (color + transparency). Default R=38, G=127, B=0, A=150. 

BLA fill color 
R, G, B, A (color + transparency). Default R=180, G=255, B=147, A=50. 

BLA selected color 
R, G, B, A (color + transparency). Default R=180, G=255, B=147, A=150. 

Join border color 
R, G, B, A (color + transparency). Default R=255, G=10, B=4, A=150. 

Join fill color 
R, G, B, A (color + transparency). Default R=255, G=117, B=114, A=50. 

Join selected color 
R, G, B, A (color + transparency). Default R=255, G=117, B=114, A=150. 

Unassigned region color 
R, G, B, A (color + transparency). Default R=255, G=250, B=250, A=100.  

Area off fill color 
R, G, B, A (color + transparency). Default R=0, G=0, B=0, A=50 

Area on fill color 
R, G, B, A (color + transparency). Default R=255, G=255, B=0, A=200 

Occupancy map occupied fill color 
R, G, B, A (color + transparency). Default R=255, G=0, B=0, A=255 

Occupancy map unoccupied fill color 
R, G, B, A (color + transparency). Default R=255, G=255, B=255, A=255 

Occupancy map unknown fill color 
R, G, B, A (color + transparency). Default R=0, G=0, B=0, A=50 

Area name text color 
R, G, B, A (color + transparency). Default R=0, G=0, B=0, A=255 
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Lines 

Fixture group line color 
R, G, B, A (color + transparency). Default R=0, G=0, B=139, A=255 
 
DyNet cable line color 
R, G, B, A (color + transparency). Default R=255, G=140, B=0, A=255 

DALI cable line color 
R, G, B, A (color + transparency). Default R=0, G=100, B=0, A=255 

Fixture control line color 
R, G, B, A (color + transparency). Default R=139, G=0, B=0, A=255 

DALI control line color 
R, G, B, A (color + transparency). Default R=128, G=0, B=128, A=255 

Fixtures 

Fixture off fill color 
R, G, B, A (color + transparency). Default R=64, G=64, B=64, A=255 

Fixture on fill color 
R, G, B, A (color + transparency). Default R=255, G=255, B=0, A=255 

 

Comms Engine 

Enable routing 
True/False, default True. 

Number of concurrent RS485 commands 
Minimum 0, maximum 20, default 1. 

Number of concurrent ethernet commands 
Minimum 0, maximum 100, default 5. 

Use optimization when loading data from device memory 
True/False, default False. 

User memory verification before saving modified data to device 
True/False, default False. 

Open network connections in exclusive mode 
True/False, default True. 

Use DyNet 2 DALI Tunnelling 
True/False, default True. 

Use two byte DALI firmware upgrade 
True/False, default True. 

Request DyNet 2 preset using channel 1 
True/False, default True. 

Rx timeout (milliseconds) 
Minimum 300, maximum 10000, default 300. 
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Reset delay (milliseconds) 
Minimum 0, maximum 30000, default 3000. 

Failed network message enabled 
True/False, default False. 

Failed network message auto resend expiry (in minutes) 
If connections are restored then failed network messages will be automatically resent up 
until this time period in minutes from the time of the original message. Minimum 0, 
maximum 1440, default 60. 

Failed network message auto removal time (in minutes) 
Failed network messages can still be manually resent until this time period expires. After this 
period, they will be automatically removed from the list. Minimum 0, maximum 10080, 
default 1440. 

Deployment 

Max. Concurrent Deployments 
Maximum number of concurrently executing deployments. Minimum 1, maximum 20,  
default 5. 

Max. Concurrent Deployments per Floor 
Maximum number of concurrently executing deployments per floor. Minimum 1, maximum 
20, default 3. 

Retry delay (mins) 
Delay (in minutes) between retry attempts for failed deployments. Minimum 1, maximum 
2880, default 30. 

Alarms 

Enable Meter Value Under/Over Reference Alarms  
True/False, default True. 

Enable All Events  
True/False, default True. 

Enable User LogOn/Off Events  
True/False, default True. 

Enable Schedule Started/Stopped Events  
True/False, default True. 

Enable Task Started/Stopped Events  
True/False, default True. 

Enable Connection Alarms  
True/False, default True. 

FIAS offline alarm connecting time  
Minimum 20, maximum 1000, default 0 

DyNet offline alarm connecting time  
Minimum 20, maximum 10000, default 0 
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Hotel 

Maximum Hotel event logs 
Number of event log items shown in SM client room view. Not applicable to web dashboard 
room view. Minimum 0, maximum 100, default 20. 

Store hotel status  
SM server will update the database with room status change so that the last status received 
is shown after a server restart. True/False, default True. 

Enable hotel status polling at server startup 
SM server will poll room state after a restart. Not recommended. Expect only on a small 
hotel due to possible network traffic issues. True/False, default False 

Enable manual check-in 
Configures if the user can override check-in/check-out state from room view.  
True/False, default True. 

 

Batched Log 

Batched Log 

Enable 
True/False, default False. 

URL 
Enter URL. 

Key name 
Enter Key name. 

Key  
Enter Key. 

Queue  
Enter queue. 

Message check interval (milliseconds) 
Minimum 1000, maximum 60000, default 3000. 

Clear unmatched message 
True/False, default False. 

Logging 

Write messages to the file 
True/False, default True. 

Log file path 
Enter log file path. 

Log file removal 

Log file removal method 
Maximum days to keep saved log files: Maximum Days, Maximum Size, Don’t delete. 

Maximum Days to keep saved log files 
Minimum 0, maximum 10000, default 10. 
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Maximum size (MB) of saved log files 
Minimum 0, maximum 10240, default 100. 

 

SMTP Server 

Used to establish a connection with an SMTP server to enable email notifications. 
Simple Mail Transfer Protocol (SMTP) is the standard protocol for electronic mail 
transmission.  

General settings 

Enable email notification 
Set to Enabled to receive email notifications regarding alerts. Default it is set to Disabled. 

Primary SMTP Server 

Server name 
Enter the name of the SMTP server. 

Port 
Enter the port number. Ensure that the port number is correct for the security selected as 
there may be a few SMTP servers that would use a different port number for different 
connection types. 

User name 
Enter the user name for authentication on the server. 

Password 
Enter a password for the given user name. 

Security 
Select the encryption type from the drop down. None, SSL/TLS, Start TLS.  

Secondary SMTP Server 

Server name 
Enter the name of the SMTP server. 

Port 
Enter the port number. Ensure that the port number is correct for the security selected as 
there may be a few SMTP servers that would use a different port number for different 
connection types. 

User name 
Enter the email address of user who would receive the email notification. 

Password: 
Enter a password for the given user name. 

Security 
Select the encryption type from the drop down. None, SSL/TLS, Start TLS. 

Test Primary – is used to test the connection to the Primary SMTP Server. 

Test Backup - is used to test the connection to the Secondary SMTP Server. 
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SMTP Message 

The SMTP message displays the format of the email message that the SMTP server sends 
out to people who will be notified. 

Importance – Select the importance of the email as Low, Normal or High from the drop-
down list. 

Message Template – Check the Use HTML check box to display the message in HTML 
format. A customized email template can be attached by clicking Open Custom template 
and attaching the template file. 

Custom Subject – Enter the text if you want a custom subject line. 

The basic format of the SMTP message is displayed below. 

Message Content Description 

@Model.Attention Displays the recipient name. 

@Model.Severity Displays the alert severity (High/Medium/Low.  

@Model.Status 
Displays status of the alert  
(Created/Acknowledged/Restored/Restore Acknowledge/Cleared). 

@Model.Time Displays the time stamp. 

@Model.Type Displays the Alert type (Fault/Alarm/Event). 

@Model.Description Provides details on the alert. 

@Model.Location Provides location details of the alert. 

@Model.Comment Displays the comment text. 

@Model.Profile Name of the notification profile. 

@Model.EventData Displays Event data, if applicable 

 

Presence Detection 

Presence Detection - Enables user presence detection by the SM Switch software 
application. Switch is a software application that can be linked to a PC’s screen saver 
behavior and can be used to control the lighting above the desk where the computer is 
placed. The lights can go into different presets depending on the user presence state 
detected. 

There are three user presence states supported for every area defined in the floor plan. 
These are: 

• Occupied 
Occupied state is when the user is active and Switch client is active on the PC. 

• Suspended  
Suspended state is when the Switch client is not active, and the windows 
screensaver is running. 

• Unoccupied  
Unoccupied state is when the Switch client is not logged in. 
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Add Presence detection: 

1. Select the Area for which presence detection is to be defined. 
2. In the properties pane, Enable Preset detection. 
3. Select Preset, Fade, Join and Delay. By default, the presets for Occupied, 

Suspended and Unoccupied are set as High, Low and Off. The Default presets for 
these states can be changed. 

Repeat the steps for each area that required presence detection is required. 

 

Public Holidays 

Public holidays can be defined specifically for every site that has System Manager. 

Add a public holiday 

1. Select the date on the calendar on the right of the displayed window. 
2. Click Add 
3. Use the Deploy button to implement the changes. 

Public holidays can also be imported, exported, deleted and/or renamed. Exporting 
calendars are supported in xml format and while imports additionally supports ics 
format calendar files.  

 

Notifications 

System Manager can be set up to send notifications regarding any alert (faults, alarms and 
events) in the lighting system. Users are notified by an email when specified alert occurs. 

• Faults that can occur in the lighting system include device offline or a ballast on a 
network being offline.  

• Alarms can be created for lamp failure or lamp life over.  

• Event notifications such as user log on, user log off are created.  

D Note: A Custom Fault, Alarm or Event command can be configured from a device input or 
an SM Custom button to send a Raise Alert message. For more information refer to the 
Action Editor in SB or SM.  

 

Configure notifications 

1. In Notifications, click Add to create a new notification 
2. Enter a name for the notification profile 
3. Check the Alert Type for which the recipient will be notified or click the Configure 

Custom button to create a custom alert. 
4. Click the checkboxes for the required Faults, Alarms or Events. 
5. Click OK. 

This creates the notification profiles. Email recipients then must be added to the notification 
profiles, so they are notified when an Alert occurs. 



  September 6, 2022 

System Manager 40  

Add Recipients 

1. In Notifications Recipients tab, click Add or Add System Manager User. 
2. Enter the Name and Email address of the recipient or select the recipients from the 

User account list and click the Add Checked button. 
3. Click Test Selected to verify the email address of the recipient. 

 

Location and Time Zone 

The Location and Time Zone page displays the site location and time zone settings. The 
Time zone settings affects events that are based on astronomical time such as sunrise and 
sunset. Time based events are scheduled from the server’s system clock.  
Select the correct Country and a City (in that country) that matches the local time zone.  
If required adjust the Time Zone from the dropdown list. 

 

Data Access 

If installed, this enables access to the API for the Lighting Dashboard and the Interact 
Hospitality Dashboard 

 

Hotel Settings 

If installed with a Hotel License, these settings this enables you to access the Interact 
Hospitality settings: 

• Room Templates – Can only change settings for existing templates. 

• Rooms (mapping table) – Can only change FIAS server selection. 

• Room Alerts – Read only 

• Guest Languages – Can add selected languages. 

• FIAS 
o Servers – Can add FIAS servers 
o Command – Can configure FIAS commands 

For more information, refer to the Interact Hospitality Commissioning Guide. 

 

Access Control 

If installed with a Hotel License and enabled, these settings this enables you to monitor 
messages with an Integrated Access Control system. 

 

Deployments 

Lists deployments of firmware, configuration and variable bulk updates. You can enable and 
disable existing deployments. 

 

Selling Partner 

A record of the Selling Partner details. 
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Manage Users 
The Manage Users button establishes user access control for the site. This feature can be 
used to: 

• Add users to the site 

• Create and define different user roles  

• Maintain tenancy groups. 

Click the Manage Users button to display User Access Management 

Users 

System Manager users can be added using the Users page. Users can be classified and 
associated to the available user roles and tenancy groups that exist in the system. 

Add Users: 

1. Open the User Access management window. 

2. Select Users in the tree  

3. Click Browse to select a username from your local/corporate directory. You can click 
the Advanced button to find a user with an advanced query. 

 

4. Click Add Empty to manually enter a username and email address. 
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5. Select the Member of User Role checkboxes. Check against the required User Roles. 
All the user roles in the system are displayed here. 

 

6. Select the Member of Tenancy Group checkboxes. Check against the name of 
required Tenancy Group. The tenancy groups define the areas in the building that 
are accessible to each tenant.  

 

The user has been created and associated with specific user roles and tenancy 
group. 
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User Roles 

User Roles creates individual site users with specific set of securable services they can 
perform. Securable services define or limit the functionality of a user role depending on the 
user profile. 

By default, System Manager has the following user roles defined. 

• Guest User 

• Normal User 

• Power User 

• Super User 

Securable services that can be accessed by each user, are defined while creating the user 
role. For example, a guest user can log on to the System Manager client, view various areas 
in the plan, recall presets and recall channel levels whereas a super user can perform all 
securable services. 

Add a User Role: 

1. Click Manage Users on System Manager Configuration. This displays the User 
Access Management window. 

2. Select User Roles from the tree 

3. Click Add 

4. Enter a name the user role created 

5. Select the actions/functions that the user role can perform by checking the any 
securable services on right side of the displayed window. This creates a User Role. 
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User Permission Table Defaults 

Type of User/ 
Securable Service 

Guest User 
Super 
User 

Normal User Power User 

Recall Presets     

Recall Logical Levels     
Request Current Preset     

Request Logical Level     
Program Presets     

Sign On Devices     
Reset Devices     

Request DALI Ballasts     
DALI Emergency Testing     

User Access Management     
Control Schedule     

Write Schedule     
Control Macro     

Write Macro     
Control Trigger     

Write Trigger     
Write Job Setting     

Write Public Holiday     
Write Alarm Event Notification     

Write Bookmark     
Write Button     

Control Button     
Log On     

Control Notification System     
Server Configuration     

Database Management     

Write Presence Detection     

Control Lamp Manager     

Retrieve Trend Data     

Diagnostic Debug     
Console View     

Site Map View     

Maintenance View     

Reports View     

Alerts View     

Sensor Timeout Configuration     

Sensor Auto Calibration     

Sensor Lux Levels     

Set Temperatures     

Modify Areas     
Rename Areas     
Network Management     
Supervisor Sign-in     

 

D Note: The Write Button function enables the user to edit pages and see hidden pages. 
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Tenancy Groups 

A tenancy group allows users to access certain parts of the system. These parts in the 
system are called Securable Resources: 

• Physical Plans 

• Global Areas 

• Global Devices 

• Button Pages 

• DALI Emergency Groups 

• System Manager Schedules 

• System Manager Tasks 

• System Manager Triggers 

• System Manager Tags 

 

Add a Tenancy Group 

1. Click Manage Users on System Manager Configuration. This displays the User 
Access Management window. 

2. Select Tenancy Groups in the tree 

3. Click Add 

4. Select the Securable Resources 
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Manage Databases 
There are three main databases that are created during Philips Dynalite System Suite 
installation are: 

• Job (Config) Database 

• Trending Database 

• Alarms & Events Database 

In the event of a computer failure, to protect all the information, regular database 
maintenance needs to be performed. 

Click the Manage DB’s button to open Database Maintenance window. 

  

The following actions can be performed from Database Maintenance window: 

• Choose a working database 

• Backup Database 

• Restore Backup 

• Archive Database 

• Reload and Upgrade Databases 
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Choosing a Database 

The working database wizard selects the active databases for System Manager. 

Choose a Database 

1. Click the Choose a Database button from the Database Maintenance window. This 
opens the Job Database wizard. 

Select the Server Name as Computer Name\SMSERVER and select the working 
Database Name from the dropdown list. 

Click Next 

2. Select the Trend database. 

Check Create Database if it doesn’t exist if the database is not created previously. 
Click Next. 

3. Select the Alarms and Events database.  

Check Create Database if it doesn’t exist if the database is not created previously. 
Click Next. 

4. Select the Reports database, if required. In case it is not planned to export reports 
to a database, leave this field blank. 

Check Create Database if it doesn’t exist if the database is not created previously.  

Click Next. 

5. Click Execute. 

6. Click Finish to exit wizard 
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Backing up a Database 

Backup the Databases regularly to create a recent copy of the active database in case the 
active database becomes corrupted. 

Backup Database 

1. Click Backup Database on the Data Maintenance window. 

 

2. Check the database that needs to be back up and click Next 

3. Click Execute to backup database  

4. Click Finish to close the wizard. 
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Restoring a database 

Restore Database 

1. Restore database retrieves the data from a previous backup. 

2. Click Restore Database from Database Maintenance 

 

3. Check the database that needs to be restored and click Next 

4. Click Execute to restore database  

5. Click Finish to close the wizard. 
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Archiving a database 

Archive Database 

When it is not required to retain all historical data in the database, it is possible to move this 
data to an archive database. 

1. Click Archive database from the Database Maintenance window. 

 

2. Select the Archive data before date so that the data before the selected date can be 
archived. 

3. Select the database that needs to be archived. Click Next. 

4. Click Execute. 

5. Click Finish to exit wizard. 
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Reloading and Upgrading Databases 

If the working database is modified by System Builder, then before running System Manager 
Client, the database should be Reloaded and Upgrade to the modified version. 

 

 

Saving to a database in System Builder 

This procedure explains how to save an existing System Builder job file for use in System 
Manager. 

1. Open the existing project with System Builder. 
2. Click File > Save As > Save To Database. 

 

3. Enter the Server Name 
4. Select the database from the Database name drop down, or if you want to create a 

new database type the name of the database in the field. 
5. Click OK 
6. Your project has now been saved to the database and can be opened using System 

Manager. 
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Creating a new database in System Builder 

To create a System Builder project from scratch for use in System Manager follow the steps 
below: 

1. Open System Builder. 
2. Click File > New > New Empty Database. 

  

3. Enter the server name or enter.\EMSERVER. 
4. Enter the database name. 
5. Enter the name for the Job title. 
6. Click OK.  

Now you have created a blank database for System Manager. 

 

Opening a database in System Builder 

To open a System Manager database in System Builder and make changes follows the steps 
below: 

1. Stop System Manager Server from Windows Task Manager services.  
2. Open System Builder. 
3. Open the System Manager Database that has the SM Database using File > Open > 

Open database. 
4. Click OK. 

 

5. Make the required changes in System Builder. 
6. Save to the database. 
7. Close System Builder. 
8. Start System Manager Server. 

 

D Note: If you do not save to the database, you may lose all the changes 
you have made to the configuration in System Manager. 
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Monitor System 

Application Log 

 

 

The Application Log toolbar appears at the top of the Application Log window. The 
following commands are available from the toolbar in the Application Log: 

 Open Existing Log File 
Opens a previously saved daily log file. 

 Save current Log Entries 
Saves a backup copy of the current log file. 

Open Complete Current Log 
Opens a new page in the monitor window showing all log files for that day. When the log 
file’s maximum limit is reached a new log file is created for that day.  

Open Previous Log  
Opens the previous daily log file before the one currently being viewed.  

Open Next Log 
Opens the next daily log file after the one currently being viewed.  

 Start Logging 
Updates the application log in real time 

 Pause Logging 
Freezes the application log display 

 Clear Log Entries 
Clears the Application log display. Entries are still available in the saved log file. 

 Ascending/Descending Order 
Sorts messages in ascending/descending order according to the ID number. 

 Show/Hide Columns 
Allows to select the columns from the available list. (See picture) 

 Copy Selected Log Entries 
Copies the entire log entry to the clipboard. 

 Find 
Finds the specified text in the log file entries 

 Find Next 
Find the next log entry matching the specified text 

 Find Previous 
Find the previous log entry matching the specified text 
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    Message type filtering 
The message types available are shown in the following table:  

Message Type Icons 

 Show Log Detailed Information 

 Show Log Information 

 Show Log Warinings 

  Show Log Errors 
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Network Log 

 

 

The Network Log toolbar appears at the top of the Network Log window. The following 
commands are available from the toolbar in the Network Log: 

 Open 
Opens a previously saved daily log file. 

 Save 
Saves a backup copy of the current log file. 

Open Complete Current Log 
Opens a new page in the monitor window showing all log files for that hour. When the log 
file’s maximum limit is reached a new log file is created for that hour.  

Open Previous Log  
Opens the previous hourly log file before the one currently being viewed.  

Open Next Log 
Opens the next hourly log file after the one currently being viewed.  

 Start Logging 
Updates the application log in real time 

 Pause Logging 
Freezes the application log display 

 Clear Log Entries 
Clears the Application log display. Entries are still available in the saved log file. 

 Ascending/Descending Order 
Sorts messages in ascending/descending order according to the ID number. 

 Show/Hide Columns 
Allows to select the columns from the available list. (See picture at right)  

 Copy Selected Log Entries 
Copies the entire log entry to the clipboard. 

 Find 
Finds the specified text in the log file entries 

 Find Next 
Find the next log entry matching the specified text 

 Find Previous 
Find the previous log entry matching the specified text 

 Clear Find All 
Removes the highlight from entries found with the find all function 



  September 6, 2022 

System Manager 56  

 Toggle Bookmark 
Adds and Removes bookmark on selected line. Bookmarked entries are shown in Bold.  
Bookmarks are saved in all logs. 

 Next Bookmark 
Finds the Next bookmark 

 Previous Bookmark 
Finds the previous bookmark 

 Delete All Bookmarks 
Removes all bookmarks from the current Network log.  

 Show Names 

For devices it displays the name given in the target logical column. It also displays device 
names for physical messages. For Areas, Channels and Presets it displays the name given in 
both the description and the target logical columns. 

 Show Data 

Opens a new window displaying the hex string for the message selected in the 
Network log 

 Show Details 

Opens a new window displaying a description of the selected DyNet message 

 Scroll Details 

Displays the details of each new message in the network log.\ 

Network Log Colors 

The color of each Network Log Entry indicates the following conditions: 

Color  Meaning 
Yellow Find all highlight 
Orange  Bad packet 
Medium Green Program preset 
Light Green Logical message 
Light blue Device application sign-on 
Royal Blue Bootloader sign-on 
Light Coral Device reset 
Firebrick Bootloader reboot 
Wheat Device load and save 
Thistle Firmware upgrade 
Tan All other physical messages 
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Command Monitor 

 

The Command Monitor displays the status and sequence of EP commands. The following 
commands are available from the toolbar in the command monitor: 

 Cancel Selected Command  

Cancels the current command selected in the command monitor. 

 Cancel All Command 

Cancel all running and currently queued commands. 

 Ascending/Descending Order 
Sorts messages in ascending/descending order according to the ID number. 

 Show/Hide Columns 
Allows to select the columns from the available list. (See picture) 

 Copy Selected Log Entries 
Copies the entire log entry to the clipboard. 

 Clear Completed Commands 
Clears all commands from the Command Monitor window. 

 Show Completed Commands 

If ticked completed commands are displayed in the list. If unticked, completed commands 
are not displayed 

 Show simple Commands 

If ticked simple messages are displayed in the list. If unticked, simple commands are not displayed 

Commands will be in one of the following states: DyNet Commands are categorized into the 
following command types: 

 

Command States  Command Types 

 Command Queued  Physical Command 

 Command Delayed  Physical Request 

 Command Active  Logical Command  

 Command Active Delayed  Logical Request 

 Command Complete  Device Load 

 Command Expired  Device Save 

 Command Cancelled  Device Attributes 

 Command Superseded  Device Change Box Number 

 Command Failed  Device Firmware 

  Device Discovery 
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Philips Dynalite 
www.lighting.philips.com/dynalite 
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